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1. Activation 

 
Activation using Windows  

Upon starting DENOISE projects 3 professional for the first 

time you will be prompted to activate the program. Proceed as 

follows:  

Install DENOISE projects 3 professional as described by the 

installation instructions.    

Input your serial number. For the box version, this can be found 

on the accompanying booklet. If you have chosen to download the 

program, you will find the serial number in your customer account 

at www.franzis.de. 

 

Finally, click on the “Activate” button. The software has now 

been successfully activated! 

 

Activation using Mac  

Upon starting DENOISE projects 3 professional for the first 

time you will be prompted to activate the program. Proceed as 

follows:  

Install DENOISE projects 3 professional as described by the 

installation instructions.    

Input your serial number. For the box version, this can be found 

on the accompanying booklet. If you have chosen to download the 

program, you will find the serial number in your customer account 

at www.franzis.de. 

http://www.franzis.de/
http://www.franzis.de/
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Finally, click on the “Activate” button. The software has now 

been successfully activated! 

 

Note: DENOISE projects 3 professional can be installed on 

up to two computers using the same serial number.   

A second serial number is not required. When installing the 

program on a second device, simply enter the serial number 

again and press “Activate”.   
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2. Image Noise – what is it? 
 
Image noise occurs in digital image generation in different ways.  
 
On the one hand there is the so-called dark noise, which is 
caused by sensors on CDD and CMOS sensors. An additional 
multiplier is the readout amplifier in digital cameras, which 
generates the readout noise. 
 
With increasing age or due to manufacturing inaccuracies in the 
image sensor, so-called hot pixels occur. These are individual 
pixel sensors that have been manufactured incorrectly or have a 

significantly higher light sensitivity than the surrounding pixels. 
 
In general, the higher the ISO number (i.e. the light sensitivity 
setting of the camera), the more visible the noise becomes. 
 
What types of image noise can you reduce or remove with 
DENOISE projects 3 professional? 
 

 Chroma Noise (coloured noise) 
(Filter: Denoising – Farbe) 

 Luminance Noise (brightness noise) 
(Filter: Denoising – HD) 

 Hotpixel 
(Filter: Denoising – hotpixel) 

 Salt & Pepper (single pixels of distortion) 
(Filter: Denoising – hotpixel) 

 Gaps 
(Filter: Denoising – fill gaps) 

 Banding 
(Filter: Denoising – banding) 

 Colour Clouds 
(Filter: Denoising – colour clouds) 

 
In most cases, the different types of image noise do not occur 
individually, but in a mixed form. Therefore, it is important to 
perform the noise reduction in the correct order (shown above) in 
order to achieve optimal results. 
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3. Quickstart with DENOISE projects 3 

professional – image noise free photo in 

only three steps 

 
DENOISE projects 3 professional is an extremely powerful tool 
for editing images. The only limitation you have is your 
imagination. Especially people who use the software for 
professional purposes will appreciate the individual settings. For 
the average user, however, it is usually sufficient to have a 
snapshot of DENOISE projects completely noise-free 
automatically. 
 
This is how the quick start with DENOISE projects works: 
 
Step 1: Open your photo in DENOISE projects 3 professional. 
To load a photo, simply drag and drop the image files onto the 

program interface. Alternatively, select the toolbar or the file 
menu. 

 

 
 
Step 2: Wait a few seconds as the image will be automatically 
denoised by the software. You will receive a confirmation 
message, when the process has been completed. 
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Step 3: Save the finished result in a chosen folder. 
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4. What´s new? 
 

 Comprehensive Enhancements to Automatic 
Denoise Functions:  

 Noticeably improved precision in 51 grades (previously 
30) 

 ISO range from ISO 10 to ISO 5.000.000 
 Now including automatic colour cloud removal  

 
 New: Quality modes for automatic denoise: Balanced, 

Pro and Pro+ 
 

 New Developments in Automatic Optimization: 
Automatic optimization of:  

 Brilliance 
 Colour Normalization 
 Sharpness 

 
 New Functions in the Noise-Stacking Module: 
 Drizzle algorithm for increasing image resolution by 

200% 
 New stacking mode “Median” 
 Complete distribution of bias frames 
 New RAM and HDD virtual memory management for 

even faster noise stacking 
 Automatic colour correction normalization with flat 

frames 
 Save stacking results in 32-Bit image formats 

 
 Redesigned Denoise Interface: 
 New Denoise Automatics Interface 
 All regions are now collapsible and interface layout 

preferences save automatically 
 

 Smart-Grain Selection Window: Now there is a virtual 
selection window for Smart Grain settings. This window 
appears automatically when starting the program or via 

Extras  Reset 

 
 Additional Presets: 173 Presets 
 New Post Processing Filters: DENOISE projects 3 

professional includes 16 new Post Processing Filters 
 Denoise HD ultra+ (Luminance) 
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 Rotation and Zoom 
 Horizon Alignment 
 Perspective Correction 
 Trapezoidal Distortion Correction 
 Exposure 
 Weighted Black / White Point 
 Histogram Comparison 
 Normalization 
 Precise Percentile Adjustment 
 White & Black Correction 
 Colour Filters 
 Colour Channel Gamma Correction 
 Normalisation (RGB) 
 Aura 
 Gauss Blur 

 
 6 New Smart-Mask-Filters:  
 Smooth areas 
 Luminance 
 Colour saturation 
 Midtones 
 Gradation 
 Vignette  

 
 New Composing Module in Selective Painting: 
 4 Layers of Composing images which can be integrated 

into the denoised result at any time 
 66 layer-allocation methods included 
 Watch as real-time changes in brightness, contrast and 

colour are applied to your Composing Image 
 

 New Functions in Selective Painting:  
 New effects: selective denoising, correct red eye and 

beauty  
 Boolean functions to combine masks 
 Mulitple UnDo & ReDo of the paintbrush-tool 

 
 New 1:1 Comparison Window 

Comparison Modes: 
 Split left/right, split right/left 
 Adjacent left/right, adjacent right/left 
 Right/ Left 
 Zoom Function 
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 Revamped Noise-Stacking Automatic Image 
Alignment with selectable Image Subject Types: 

 Landscape, Architecture, People 
 Stardust, Night Sky 
 Soft Touch (strong bokeh) 

 
 Enhancements to the RAW Module: Save user 

profiles at any time 
 
New category colour filter:  

 Red   Green  
 Orange   Cyan  
 Yellow   Blue 
 Yellow-green   Violet  

New effects in RAW mode: 
 Exposure value (EV)  Soft details  
 Brightness red   Pastel colours  
 Brightness green   Bleach Bypass  
 Brightness blue   Polarising filter  
 Hue shift  Reduce stray light  
 Soft contrast   Ageing 

 
 Scaled saving of images: The new add-on module for 

image cropping allows you to save images in a smaller 
size. 

 About 30 templates for various platforms like Facebook, 
Instagram, Youtube, etc.  

 Pixel-precise input of image formats 
 

 New Layer Allocation Methods: 23 new layer 
allocation methods in HSV und HSL colour spaces. 
 

 Select a font: A font can be selected from all installed 
and compatible fonts. 
 

 Add-on to the scratch- and sensor-correction: 5 
new quality modes for searching for corresponding areas 
automatically. 
 

 Erweiterung der Externen Programme  
 Up to 12 external programs  
 Names of external programs are configurable 
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 Notes Function in the Undo Timeline 
 

 Quick-Print Images 
 

 Copy Images to the Clipboard: For sending in an 
email, for example 
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Neue RAW-Formate: 
 

 Apple iPhone 8(*), iPhone 8 plus, iPhone X  
 BlackMagic URSA Mini 4k, URSA Mini 4.6k, URSA Mini Pro 

4.6k  
 Canon PowerShot A410, A480, A540, D10, ELPH 130 IS, 

ELPH 160 IS, SD750, SX100 IS,SX130 IS, SX160 IS, 
SX510 HS, SX10 IS, IXUS 900Ti PowerShot G1 X Mark 
III, G9 X Mark II, EOS 6D Mark II, EOS 77D, EOS 200D, 
EOS 800D, EOS 2000D, EOS 4000D, EOS M6, EOS M100  

 Casio EX-ZR4100/5100  
 DJI Phantom4 Pro/Pro+, Zenmuse X5, Zenmuse X5R  
 Eyedeas E1  
 FujiFilm S6500fd, GFX 50S, GFX 50R, XF10, X100f, X-

A3, X-A5, X-A10, X-A20, X-E3, X-H1, X-T3, X-T20, X-
T100, DBP680  

 GITUP GIT2P, G3 DUO (16:9 only)  
 Hasselblad H6D-100c, A6D-100c  
 Huawei P9 (EVA-L09/AL00), Honor6a, Honor9, Mate10 

(BLA-L29)  
 Kodak PIXPRO, AZ901  
 Leica CL, M10, M10-D, M-10P, TL2  
 LG V20 (F800K), VS995  

 Nikon D850, D3500, D5600, D7500, Coolpix B700, Z6, 
Z7, P1000  

 Olympus E-PL9, E-M10 Mark III, TG-5  
 OnePlus One, A3303, A5000  
 Panasonic DMC-FZ45, DMC-FZ72, DC-FZ80/82, DC-G9 

(std. res mode only), DC-GF10/GF90, DC-GH5, DC-GX9, 
DC-GX800/850/GF9, DMC-LX1, DC-ZS70 (DC-
TZ90/91/92, DC-T93), DC-TZ100/101/ZS100, DC-
TZ200/ZS200, LX100M2  

 PARROT Bebop 2, Bebop Drone  
 Pentax KP, K1- II  
 PhaseOne IQ3 100MP Trichromatic  
 Samsung Galaxy Nexus, Galaxy S3, S6 (SM-G920F), S7, 

S7 Edge, S8 (SM-G950U),  
 Sony A7R III, A7 III, A9, DSC-RX0, DSC-RX10IV, HX95, 

HX99, RX100-VA, RX-100VI  
 Yi M1  
 YUNEEC CGO3, CGO3P  
 Xiaoyi YIAC3 (YI 4k) 
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5. DENOISE projects 3 professional – the start 

screen 
 

 
 
Starting the program for the first time will open the Smart Grain 
settings window. Here you can designate a soft or natural denoise 
preference. Selecting natural denoising will help you achieve the 
most realistic results.  
 
At the top of the screen are the main menu and a toolbar. This 
toolbar contains the following functions (from left to right): 
 

 Image data browser     

 

 History viewer      
 

 Load image      

 

 Stacking image sequence     
 

 Open project      

 

 Batch processing      
 

 Load sample 1      
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 Load sample 2      
 

 Load sample 3      
 
 
Alternatively, image data can simply be dragged and dropped 
onto the screen. The images will then automatically be uploaded.
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6. The Work Area 
 
As soon as an image file is loaded into the program, a work area 
will open up. 
 

 
 
This is divided into four main areas: 
 

a) Menu and toolbars (top) 
b) Presets (left) 
c) Image area (center) 
d) Noise reduction and expert mode (right) 

 
The individual work areas can be extracted from the interface and 
inserted into another place or onto a second screen. 
 
New Features in the Denoise Interface: All regions are now 
collapsible and interface layout preferences save automatically. 
 
Return your workspace to the default layout settings by selecting 
View  Restore window defaults in the menu. 
 
To reset the user interface to default layout settings, click on 
Extra  Reset  User Interface 

 
 
Selecting Extras  Reset  Natural Grain/ Soft Grain will 

open the Smart Grain settings window which also appears when 
starting the program.  
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Optional font size for menus and titles 

In the program´s main menu, clicking View  Font size will 

provide you the option to customise the size of the letters in the 

menu as well as in the titles of the program. 

 
 
The font size can be adjusted to the run time of the program.  
4K – monitors gives you the option to enlarge the font size for 
better readability of the menu. 
 
Select a font 
HDR projects 7 professional offers you the opportunity to 
designate a suitable font of your preference. You will find a 
selection of the installed and compatible fonts in View  Font, 

simply pick your favourite. 
If you want to change the font back to standard select View  
Font  reset font. 
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7. Menu Bar 

7.1 File 

 

 
 

File → Start  

When you are finished editing an image or would like to close 
your current image, clicking on Start (or Ctrl + N) will close the 
image currently open.  
 

File → Load image…   

Click on Load image (or Ctrl + Shift + O) to find and open the 

image that you want to work on. 
 

File → Stacking image sequence…   

If you have several images that you want to combine into a single 
image, click on stacking image sequence... 
This will open a window in which you can select what type of 
images to stack: 
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 Bias frames (photos taken with a closed aperture with 
minimal exposure time) 

 Dark frames (photos taken with a closed aperture and 
identical exposure time to light frames) 

 Flat frames (photos with uniform brightness) 
 Light frames (photos with normal exposure) 
 Light frames + bias/dark/flat (directly combines normal 

exposures with the Master Bias, Master Dark & Master 
Flat photos when stacking) 

 
Further information can be found in the chapters "8.2 Stacking 
image sequences" and "10.6 Correction images". 
 

 
 

File → Image Data Browser…   

If you are not so sure where the image is, that you want to work 
on or if you need to search for your image, just click on image 
data browser… 

 

File → History Viewer  

Clicking here will provide you with an overview of your separate 
projects and allow you to choose between them. 
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File → Save Final Image…   

If you are pleased with the finished image and want to save your 
result, click save final image (or Ctrl + S) ... 
 
 

File → Open Final Image in External Program   

If you want to edit your current photo on another editing 
program, you don’t need to leave DENOISE projects 2 
professional. Simply click on open final image in external 
program. 
 

File → Create Exposure Bracketing…   

If you want to have photos with different exposures, for example 
to create an HDR image, DENOISE projects 3 professional lets 
you quickly and easily create an exposure bracket. 
 

 
 
You have the choice whether you want to produce three, five, 
seven, nine or eleven differently exposed photos. The greater the 
number of exposure brackets you choose to include, the greater 
the amount of exposure levels you’ll have to work with in the end. 
You can also designate the exposure range for each exposure 
bracket you create as well as which method to use when creating 
exposure brackets (exposure values EV or gamma correction). 
 

File → Print Final Image  

Click here to print your final image. The image is automatically 
and correctly scaled to the print medium. 
 

File → Final Image Into Clipboard  

The final image is posted to the clipboard. You can then 
seamlessly insert it into other programs. 
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File → Projects…   

If you have already started with DENOISE projects 3 
professional and want to work on another project, simply click 
on Projects… to open another project. 
 

File → Exit   

Click on Exit (or Ctrl + F4) to close DENOISE projects 3 
professional. 
 

7.2 Edit 

 

Edit → RAW processing  

If you want to edit a photo easily, 
click on RAW Development to change colours and distort the 
image (see 8.4 RAW mode). 
 

Edit → Post-processing  

Once you have edited or denoised an image, you are in post-
processing mode. 

7.3 View 
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View → EXIF Information Window  

This window shows you (if available) all image file EXIF 
information such as location, camera type, exposure duration and 
capture time. 
 

View → Histogram  

The histogram provides you with a consolidated overview of the 
Light Distribution Information present within your photo. This 
makes it easy to recognize if your photo is over/ underexposed. 
 

View → Full Screen View On/Off  

If you feel distracted by the taskbar, you can switch to full screen 
with a click on Full screen on/off. 
 

View → Interface-Style… (dark gray)  

Click Interface Style.. to change the color scheme of DENOISE 
projects 3 professional. The color scheme currently in use is 
shown in brackets. 
 

View → Font  

Choose your individual font from all compatible and loaded fonts. 
DENOISE projects 3 professional now displays the entire 
interface in the font you selected. 
 

View → Font Size …  

Change the font size levels between small, medium and large. 
 

View → Frame Colour: Gray Cart → automatic  

If you click on Frame Colour: Gray Cart, the program will set the 
your image’s average colour value as the frame colour. 
 

View → Restore Window defaults   

Returns the current window to its original size.  
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7.4 Extras 

 
Extras → Batch processing… 

(Ctrl + B)  

Batch processing in DENOISE 
projects 3 professional 
allows multiple exposure series 
to be processed automatically. 
 
 
 
 

Extras → Preparing image…  

 

 
 
a) White balance: With white balance, you can correct color 
casts caused by warm room lighting, for example, when taking 
pictures. 
 
b) Colour temperature: With this control the colour 
temperature can be adjusted during loading. It is recommended 
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to leave the setting at "Default" and to adjust the colour 
temperature later in the post-processing settings. 
 
c) Colour space conversion: Here advanced users can set the 
colour space of the image. However, since most monitors can 
only display the sRGB colour space, you should only change the 
colour space if absolutely necessary. 
 
d) Optimisation: Normalise colour ensures that the shadows 
in the image are black and the lights in the image are white. The 
adjustment RAW to camera display converts the RAW image 
during loading so that it comes as close as possible to the preview 
of the camera and the file preview. The automatic RAW 
luminocity optimisation can be activated in the image 
preparation in the RAW Options area. It is often the case with 
camera RAW formats that the image data does not take 
advantage of all possible tonal values. The automatic luminocity 
optimisation compensates this for the loaded RAW images and 
expands the tonal values so that a sensibly exploited histogram is 
created for each camera RAW image. If the automatic rotation 
of images is activated, they are automatically rotated according 
to the Exif orientation. 
 

e) Alignment: Activate/deactivate the automatic alignment of 
the input images here. Finest movements of objects, unintended 
zooming, rotation of the camera and micro details can be 
considered here - the default setting leads to the preferred result 
in most cases. Under Motif type you can now choose between 
"Star Nebula, Night Sky" or "Landscape, Architecture, People" or 
"Soft Motifs (Strong Bokeh)" to achieve the right orientation for 
your image. 
 

Extras → Benchmark  

If you would like to know how quickly your PC can remove noise 
from your images, Benchmark is the function to choose. The 
programs will render five different images in real-time and 
provides you with an evaluation on a five-star scale. 
 

Extras → Settings (Ctrl + P)  

Here you will find many different settings to customize DENOISE 
projects 3 professional to your needs. 
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Program: Program location 
Here you can define in which folder projects, single images, final 
images and presets are stored. 
 
Program: Gamma conversion 
Here you can set the gamma value for the development for all 
loading and saving processes of images in the formats .hdr and 
.exr. 
 
Program: Language/ Langue/ Sprache 
Here you can switch DENOISE projects 3 professional to 
English, French or German. 

 
 
 
Program: Accelerate GPU  
Here you can activate or deactivate the acceleration of the 
calculation by the graphics card. 
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Program: Tooltips 
If you hold the mouse pointer over certain tools or menu items 
for a longer period of time, a text will appear explaining the 
function. This is called a tooltip. Here you can deactivate these 
tooltips. 
 
Program: Progress bar 
During the calculation of effects in DENOISE projects 3 
professional, the progress of this application is visualized using 
a progress bar. Here you can specify when or whether the 
progress bar should be displayed. 
 
Program: Projects 
During the calculation of effects in DENOISE projects 3 
professional, the progress of this application is visualized using a 
progress bar. Here you can specify when or whether the progress 
bar should be displayed. 
 
Program: Undo 
With the option save undo steps in projects all Undo levels are 
saved in the project file and completely restored when loading. 
This creates much larger project files. Set the maximum number 
of desired Undo steps (1, 5, 10, 20 or 50). If you do not want a 

maximum number, select "unlimited". The minimum free hard 
disk space indicates how much memory on your hard disk will 
not be used by undo levels. This ensures safe operation of the 
operating system. The default value is 10% of the hard disk 
capacity, but you can also reduce or increase it. 
 
Export 
External programs 
Here you can set the format in which DENOISE projects 3 
professional should export images to external programs. You 
can also specify exactly which programs should be used for 
external image processing.  
Navigate to the folder in which the application is installed and 
select it. 
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NEW: You can now store up to twelve external programs and 
configure their names. 
 
 
Save formats 
 
Jpg 
Jpg or Jpeg is the most common and popular format for most 
cameras and image processing programs. Here you can set the 
output quality and also compress the images optimally. High 
quality compressed images look better, but take up more space. 
 
Tif 
Here you can choose between different compression methods for 
compressing Tif files. 
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Png 
Four compression levels are available for storing Png images in 
16-bit.

 
 
Automatic 
 
Automatic: Denoising properties 
Here you can activate or deactivate the denoising optimisation 
after loading a photo as well as the automatic reset of the quality 
mode for the picture denoising. If you want to use a higher 
quality mode in batch processing, clear this option and the 
currently set quality mode will remain in batch processing. 
 
Automatic: Post processing 
Automatically resets the grain module to the default values with 
each new project started. To use a fixed grit value in batch 
processing, set it directly in the program and then set this option 
to inactive. 
 
Automatic: Security questions and additional information 
Here you can choose whether security prompts or additional 
information should be displayed or no longer occur. 
 
Automatic: Automatic undo points 
Automatically generates an undo point before RAW development, 
sensor error correction or selective drawing. This gives you an 
absolute starting point after loading the image. 
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Automatic: Image preparation 
Here you can set whether the image preparation window is 
displayed when images are exported via a plug-in. 
 
Automatic: Image saving 
If you activate the option "Show cropping window when saving", 
the cropping window is automatically displayed before the image 
is saved. 
 
Automatic: Batch processing/ image data browser 
Here you can activate automatic loading when opening the image 
data browser with the last used directory and/or automatic 
inclusion of subdirectories in the image data browser and batch 
processing. You can also prevent files from being overwritten by 
automatically adding the original file extension (e.g. jpg, tif,...) to 
the file name created in batch processing. 
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Extras → Create Restore Point (Shift + Z)  

If you would like to save your image in its current state and 
continue editing without initiating a file-save, simply select the 
option Create Restore Point or (Shift + Z). This allows you to 
return to the last saved state of your image at any time. 
 

Extras → Timeline (Ctrl + T)  

Click on the Timeline or (Ctrl  + T) to display all saved Undo-
Points.  
 

7.5 Add-ons 

 
Extras → Import Add-on  

Using add-ons, you can not only import presets into DENOISE 
projects 3 professional, you can also integrate new post-
processing modules that may be required for a new preset look. 
Currently there are no add-ons available. 
 
Extras → Remove Add-on  

Use this button to remove the add-on. 
 
Extras → Add-on Information 

All information about the add-ons used is displayed here. 
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7.6 Information 

 
Information → DENOISE projects – Homepage  

Click here to go to the homepage of DENOISE projects 3 
professional. 
 

Information → Show Shortcuts…  

Here you will find a clear list of all keyboard shortcuts in 
DENOISE projects 3 professional. 
 

Information → Supported RAW Formats…  

A list of all cameras whose RAW files can be opened in DENOISE 
projects 3 professional. 
 
Information → Check for updates 

Checks online if new versions of the software are available. 
 

Information → About DENOISE projects (Shift + F1)  

Information about version, 3rd party software and credits of 
DENOISE projects 3 professional.  
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8. The Tool Bar 
 
The toolbar area is divided into two areas. The left toolbar refers 
to the control functions of the program and the right toolbar 
controls the image view. 
 

 
 
The functions (from left to right) of this toolbar are: 
 

 Start 

 

 History viewer 

 

 Save project 

 

 RAW processing 

 

 Post-processing 

 

 Save final image 

 

 Print final image 

 

 Transfers the current image to the selected 
application of the product family 
 

 Open final image in external program 

 

 Create exposure bracketing 

 

 Create restore point 

 

 Timeline 

 

 Histogram 

 
 

 
 
The functions (from left to right) of this toolbar are: 
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 Real-time calculation 

When activated, all of the changes that you have made to the 
preset settings will be immediately applied to the image. If this 
option is deactivated, then you will only see the outcome of your 

adjustments when you click the button “calculate afresh”:  

 

 Recalculate image 

 

 Original resolution view 

 

 Zoom to monitor size 

 

 Additional functions: 

 

 Crop image data 

 

 Horizontal mirroring of the images 

 

 Vertical mirroring of the images 

 

 Rotate the image 90 degrees anti-clockwise 

 

 Rotate the image 90 degrees clockwise 
 

 
Some functions of the toolbar in DENOISE projects 3 
professional are now explained in more detail. 
 

8.1 Loading and saving files 

 
To load images into the program, you can either "drop" them onto 
the program using Drag & Drop, click the buttons in the toolbar of 
the start screen or load image or project data at any time using 
the File menu. 
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If you "drop" a folder onto the program using Drag & Drop, the 
image data browser is automatically opened, which displays the 
contents of the folder with thumbnails. 
 
Double-click on the preview in the image data browser to load the 
image file directly. 
 
Image formats: 
In DENOISE projects 3 professional, all common image 
formats can be loaded. This also includes camera RAW images 
from different producers. 
 
If you have RAW files available, 
you should always use them. In 
this image format, considerably 
more information is stored than, 
for example, in a Jpeg file. 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

8.2 Stacking image sequences 
– Noise-Stacking 

 
The noise stacking procedure is based on the so-called Signal to 
Noise Ratio (SNR). Here, a sequence of a motif that has been 
recorded several times under the same conditions is offset against 
each other to form an image with lower image noise. 
 
The image noise decreases in a ratio of 1: "root of number of 
images". If, for example, you photograph a subject at ISO 12800, 
you must expect a high image noise. If you now take the same 
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picture from a tripod four times in a row and place it on top of 
each other with the "Stacking image sequence", you get an 
image with 1:root from 4 → i.e. 1:2, i.e. half the image noise. 

 
This image noise can be further reduced with more shots, with 
100 shots your ISO 12800 shot would have only 1/10 (one tenth) 
of the original image noise. 
 
Using a practical example and a noise stack of 10 images, you 
can achieve the following comparison: 

 
Single image noise stack with 10 images 
 
The Image Sequence Stacking function is capable of stacking 
four various image types: Bias frames, dark frames, flat frames 
and light frames. This function also enables you to combine light 
frames with the various corrective images master bias, master 
dark and master flat. Once you’ve decided on an image noise 
correction method the images are stacked and the master images 
is saved. If not preferred, you can always select the option “do 
not remove”. 
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When selecting a combination of light frames and master images, 
more windows will appear from which you can designate the 
following settings:  
 
Image alignment mode: Rotation or shift. 
Image alignment motif selection: Starry sky, landscapes/ 
people or bokeh shots. 
Dark frame sensitivity: Fine, balanced or stable. 
Master flat analysis: Adjust brightness or do not adjust 
brightness. 
Increase image resolution: Increase original resolution or to 
200%. 
 
Bias Frames: Images with systematic sensor errors for each 
pixel – i.e. photos taken with a closed aperture and minimal 
exposure time. Bias frames are primarily stacked using the image 
correction method “Median”. 
 
Dark Frames: Images with dark noise, or dark current pixilation 
– i.e. photos taken with a closed aperture and identical exposure 
time to light frames. Dark frames are primarily stacked without 
applying image correction methods. 
 

Flat Frames: Photos taken with the entire field of view lit as 
uniformly as possible (i.e. flat field), which contain grain particles, 
sensor spotting and vignetting. Flat frames are primarily stacked 
using the image correction method “Median” or without any 
designated method. 
 
Light Frames: These are the normal exposures in an exposure 
series. Once light frames have been stacked, automatic image 
alignment is activated. Select “Rotation” or the primary alignment 
when working with the image sequences shot freehand or astro-
photography.  
 
Light Frames + Bias/ Dark/ Flat: This combines normal 
exposures with the Master Bias, Master Dark or “Master Flat” 
photos when stacking (= numerous bias, dark or flat frame 
images). If you prefer to exclude one of the correction images, 
continue by leaving the file dialogue without a selection.  
 
Median: The median process is the easiest form of noise removal 
and is especially used when stacking bias frames as well as when 
increasing the resolution of daylight images. The median process 
works for this form as few as 3 images. 
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Sigma clipping: A stable process for the removal of unclear 
objects for image stacking from 5 to 15 images. 
 
Not linear adjustment: The non linear adjustment removes 
noise very effectively with large image stacking of 15 images or 
more.  
 
Further information and examples can be found in chapter "10.6 
Correction Images". 

8.3 Projects 

 
A project contains the entire work status of the current motif. You 
can save this work status (File  Projects...  Save Project) in 

order to continue working on this work status at a later point in 
time. 
 
Undo points are also saved in the projects, so that you can access 
this work process later. 

8.4 RAW mode 

 
The RAW module is a RAW developer integrated into the program 
for your camera RAW files.  
To open the module, simply click on the "RAW" icon in the toolbar 
or on Edit  RAW Development (F4). 
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There are eleven different setting modes in this module: 
 

 White balance 

 Denoising/ Sharpness 
 Colour balance 
 Exposure 
 Details 
 Colour filter 
 Colour 
 Palette 
 Distortion 
 FX 
 General 

 
Note: Processing is possible with JPG as well as TIF images. The 
development of your image can be applied at any time in the 
work process (even multiple times). 
 
Further information on the RAW module can be found in chapter 
17. 
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8.5 External programs 

 
There are two interfaces for the transfer of an image to an 
external program. 
 
The "projects" interface: 
All programs of the projects product family are automatically 
registered here. Images can then be transferred directly by 

selecting the desired program from the list with the button  

 

 
 
In the example the transfer to HDR projects 7 professional is 
selected. 
 
The general interface: 
The general interface for external programs is configured once in 
the settings (Extras  Settings  Export). 

 
The paths for four preset external 
editors (External Image Editing, 
Adobe Photoshop™, Adobe 
Lightroom™, Adobe Photoshop 
Elements™) can be configured 
here. 
 
In the toolbar you can then 
transfer an image to one of the 
external editors: 
 
Simply click on the arrow next to 

the transfer button and select one of the options to transfer the 
image to it. 
 

8.6 Undo & Timeline 

 
Undo points can be set manually at any time. This can be done 
either by clicking the button Save Undo Point in the toolbar or 
by using the keyboard shortcut Shift + Z. 
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Each Undo Point is stored and displayed in the Timeline. The Undo 
Points contain all settings of the current editing that you can 
access at any time. 
 

 
 
 

To restore an Undo point, click on the upper button  next to 

the respective image. The Undo point will then be restored and if 
necessary an additional one will be created automatically (if you 
have made any changes). In this way you can jump between your 
Undo points and retrieve previous work statuses at any time. 
 
In addition, all undo points are saved when saving a project, so 
that all undo points are still available when recording a project 
later. 

If you click on  you can add your own note as a heading. 
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9. Presets 
 
The presets are located on the left 
side of the program interface and it 
is divided into ten different 
categories.  
 
The first two categories Noise 
suppression and Optimise contain 
presets for different ISO ranges from 
ISO 10 to ISO 5,000,000. Noise 
suppression contains presets 

suitable for fast and automatic 
denoising. Optimise, on the other 
hand, contains presets that also 
change the colours and brightness of 
the image. 
 
The Mobile and Web categories 
contain custom noise reduction/ 
optimization presets. Mobile is 
particularly suitable for mobile 
phone photos, for example. 
 
Night shot and astro, as the name 
suggests, are used for shots taken 
at night and for astrophotography. 
 
With the category All all presets can 
be displayed at the same time and 
the category Own shows only self-
created presets. 

9.1 Favourites 

 
The favourites system allows you to 
give any preset the status of a 
"favourite". 
To do this, click on the star next to the preview image. 
 
As soon as you have set one or more favourites, the category 
“favourites” becomes active. 
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With a click on the favorite category you get a display of your 
favourites.  

 

9.2 Import & Export 

 
The Import and Export area is used 
to transfer default settings. This data 
is saved as an .ini file. 
The Export button allows you to save 
the currently selected preset.  
The Import button allows you to 
import these exported presets back 
into the program at a later time. 
In this way you can save your work 
or share the presets with other 
users. 

9.3 Search area 

 
The search area is used to quickly 
find certain presets. 
You can enter any search text in the 
search input directly below the 
import buttons. All presets are then 
searched in the name for the entered 
text and displayed accordingly.  
 
For example, if you are looking for a 
preset with a soft look, type "soft" 
once in the search window. 
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10. Noise Properties (noise characteristics) 
 
The noise properties area, on the 
right-hand side of the program 
interfaces, is the core of 
DENOISE projects 3 
professional.  
 
Here you can get information 
about the noise characteristics of 
the current image, activate 
different methods, display colour 
channels, etc. 
 
These areas are introduced in 
detail in the following sections. 
 
In addition, this function block 
contains the option of integrating 
correction images such as dark 
frames and flat frames into the 
current project. 
More detailed explanations can be 
found in Section "10.6 Correction 
Images". 
 
 
If you are satisfied with the 
current noise reduction and want 
to apply it to your image again, 
you also have the option of 
clicking on the green "Play" button and thus denoising the current 
image again. 

 
 

10.1 Analysis 

 
In the first section of the noise reduction area you will find three 
ISO displays. 
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a) ISO values for the image: The upper display shows the ISO 
sensitivity of the original recording, in the example "ISO value of 
recording: ISO 1600". 
 
Directly below are the displays of the mathematical analysis of 
the image noise. 
 
b) Source image noise: Here the noise in the image is 
measured with a special method and assigned to an average ISO 
sensitivity, in the example "Source image noise: 2.3% ISO 400". 
In terms of calculation, the image contains a noise component of 
2.3%. 
The coloured indicator on the right side shows you from red to 
yellow to green whether your source image contains a lot or 
noise. 

 
 
Note: Do not be confused by the fact that the ISO number of the 
noise analysis does not correspond to the ISO number of the 
recording. 
The sensors of the cameras react differently to the set ISO 
sensitivity. The noise behaviour of a D810 differs significantly 
from that of an EOS-7D Mark II. The image noise reduction must 
therefore be based on an analytical ISO value, which is displayed 
exactly here. 
 
c) Resulting image noise: Directly below the source image 
noise you will find the analytical noise value of the result image, 
here in the example "Result image noise 0.5% ISO 80". Due to 
the noise reduction, the analytical ISO number could be reduced 
from ISO 400 to ISO 80. 
The coloured indicator on the right shows you from red to yellow 
to green whether your source image contains a lot or residual 
noise. 

 
 
Note: Be careful not to reduce the noise of the images too much, 
otherwise the natural look may be lost. A result image noise of 
0.5 to 1.0% is in most cases acceptable. 
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10.2 Automatic 

 
The analytical determination of image noise is based on a method 
that searches and categorizes the entire image for uniform areas 
without actual image details. 
The image noise is measured in these "pure" noise areas. 
 
Since the measurement of the image noise is performed 
automatically over the entire image, a manual setting of potential 
noise areas is not necessary. 
 
a) New: Three different automatic denoising modes at your 
disposal: Balanced, Pro and Pro+ 
Balanced mode enhances images with short exposure times. Pro 
mode increases calculation precision by a factor of five. Pro+ 
mode increases calculation precision by that of ten. 

 
 
b) To display these measurement ranges, click on the "Display 
calculated noise areas" button. The measured noise ranges are 
determined completely automatically. Image areas without image 
details are preferred - with increasing image noise additional 
areas with details are included in order not to underestimate the 
image noise. 

 
 
Note: During the display of the measuring ranges, you cannot 
access the automatic denoise function. Simply deactivate the 
display again. 

 
c) Automatic noise reduction: Automatic noise reduction 
analyses the current image and searches the noise reduction 
presets for optimal noise reduction. 
In this section, you can choose from five levels of Intelligent 
Noise Reduction: 

 
Intelligent automatic denoising will create a denoised 
image with an increased residual noise. 

 
Intelligent automatic denoising will create a denoised 
image with a slight residual noise. Noise reduced images 
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will often look more natural. 

 
Intelligent automatic denoising will create a 
homogeneously denoised image. 

 
Intelligent automatic denoising will create a softly 
denoised image. 

 
Intelligent automatic denoising will create a very softly 
denoised image. 

 
 
d) Automatic noise reduction and image optimisation: This 
function automatically selects a noise reduction and optimisation 
preset that matches your original image. 

 
 
e) User Denoising: Activates a preset with different denoising 
methods that you can try out as you like. Simply activate one of 
the methods in the list of selected effects. 

 

10.3 Colour dominance  

The denoising colour space is a speciality of DENOISE projects 
3 professional. 
 
With this colour space, you can improve the noise reduction 
quality in the selected shade at the expense of a slight loss of 
other colours. 

 
 
A total of ten different colour spaces are available (from left to 
right): 

 Determine colour space automatically from 
the image 

 

 Equal to the brightness perception of the 
human eye 

 

 Neutral grey  
 Red dominates (e.g. rose petals)   
 Orange dominates  
 Yellow dominates  
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 Green dominates (e.g. landscapes)   
 Turquoise dominates (e.g. sky)  
 Blue dominates (e.g. water)  
 Violet dominates     

    
Let us take a look at the example of a red rose: 

 
 
 
In the picture on the left we see the original image at ISO 25600, 
in the middle with automatic noise reduction and the selected 
noise reduction colour space "neutral grey" and in the picture on 
the right "red dominates" with the selected colour space. One can 
clearly see an improvement in detail within the flower in the right 
picture. 
 
Note: So decide on the colour space, the motif area, which you 
attach particular importance to. 
 

10.4 Channels and luminance 

This area is used for the 
optical analysis of your 
image.  
 
Note: Make sure that the real-time mode in the upper toolbar is 
active so that the display is updated. 
 
Seven display modes are available here. 

 

 Full colour display    
This display is the denoised result image with all three 
colour channels red, green and blue. 
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 Luminance display   
Brightness of the image (depending on the selected 
noise reduction colour space) 
 

 
 

 Chrominance display ( colour chart)   
In the chrominance display, you can see very quickly 
whether there is a colour noise in your motif. If the 
colours are very "restless" you should use the effect 
Denoising - colour with a higher intensity. 
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 Red channel   
In the red channel you can see the red parts of the 
image in brightness. 
 

 
 

 Green channel  
In the green channel you can see the green parts of the 
image in brightness. 
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 Blue channel  
The blue channel shows the blue parts of the image in 
brightness. 
 

 
 

 Difference to the original image  
The difference display shows the noise components 
removed from the image. 
The following applies here: The fewer details of the 
original image are visible in the difference display, the 
better the noise reduction was (the less image details 
were influenced by the noise reduction). 
As soon as you have activated the difference view, a 
slider appears with which you can increase the contrast 
of the difference display. For images with little image 
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noise, this difference is difficult to see - in this case, 
simply increase the contrast of the display.  
 
 

A comparison of the views in the picture illustrates the mode of 
operation of the display modes. 

 
Original image Luminance display Chrominance display 

 

 
 
The noise is clearly visible in the chrominance display on the 
right, it indicates a colour noise. 
 
Note: If you activate the measuring ranges, the colour noise is 
additionally displayed as a numerical value, here 30.8% colour 
noise. 
 
The brightness noise in the luminance display in the middle is 
rather low here. 

 
 

Red channel Green channel Blue channel 
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The comparison of the noise behavior in the colour channels 
provides important information for the selection of the correct 
denoising colour space. 
 
In this image section you can see a strong noise in the red as well 
as in the blue part. The green component contains comparatively 
little image noise. 
 
If we combine this information, i.e. a strong noise in red and blue, 
the violet colour space should be used here. 
 
Tip: Which colour space do I choose for which combination of 
strong colour channel noise? 
 

Red & Green = Yellow denoising colour space 
Red & Blue = Violet denoising colour space 
Green & Blue = Turquoise denoising colour space 

  
 

Original image Denoised image Differential image 
 

 
 
The differential image, (here with a difference contrast of 150%, 

i.e. amplified) shows in the area of the light tube that almost all 
noise was removed from the image. 
This can be seen from the fact that there are almost no details to 
be seen in the difference display. 

10.5 Denoising area 

 
The range restriction allows you to reduce the noise reduction to 
a certain range. 
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In this way, a direct comparison is made between the original 
image and the denoised result image. 
 

 
 
The smaller the area to be denoised the faster the calculation. If 
you are pleased with the result, activate the full-area denoising 
again (first button). 
 
The eight area modes from left to right: 
 

 Full surface (entire image) 
 Diamond shaped 
 Elliptical 
 Rectangular 
 Left side 
 Right side 
 Horizontal centric 
 Vertical centric 

 
As soon as an area restriction is activated, a control will appear 
with which you will be able to change the size of the area. 
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With a click on this symbol: you can activate or deactivate the 
border display around the restricted area. 

10.6 Correction images 

 
This section offers the possibility to denoise image data on a 
professional basis by using correction images. 
 

 
 
In contrast to classical mathematical denoising, this method is an 
exact procedure. 
 
In general, DENOISE projects 3 professional supports the 
calculation of dark frames and flat frames. 
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The buttons of the correction image area in detail: 

 
 
The buttons are divided into three areas.  
In the middle is the "Invite correction image" function. This 
button is active until a maximum of two correction images have 
been loaded. The software automatically detects whether a dark 
frame or a flat frame is loaded. 
 
On the left side there are three buttons for (from left to right): 

  Delete the currently loaded dark frame 

 
 Activate dark frame calculation 

 
 Display of the current dark frame 

 
On the right side you will find the same three buttons for 
controlling the flat frame. 
 
 
A dark frame - what is that? 
 
A dark frame (or dark image) is a recording of the sensor noise 
with the sensor covered. To take a dark frame, use an opaque 
lens cap or alternatively the camera body with protective cap and 
take a picture of the dark noise. 
 
It is important to use the same settings (exposure time and 
operating temperature) - ideally, take the normally exposed shot 
(light frame) and then take a dark frame shot immediately 
afterwards so that the temperature of your camera does not 
change too much. 
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Original Dark frame Calibrated image 
 

 
 
On the left side we see the original image, which is disturbed by 
the dark noise of the sensor. 
 
In the middle is the dark frame, i.e. the image of the dark noise. 
A strong disturbance is clearly visible in the bright pixel, which is 
also clearly visible in the original image. These disturbances are 
mostly caused by a micro defect on the sensor. 
 
Right in the image we can see the corrected (calibrated) image 
with the help of the dark frame. 
 
For the adjustment of the dark frame correction there are four 
parameters available: 
 

 Iterations 
The iterations indicate the number of passes through the 
dark frame correction algorithms. This correction method 
works very precise, a high number of iterations improves 
the accuracy, but may also produce a softer result. 
 

 Threshold 
The threshold value determines how bright the pixels in 
the dark frame must be at least for a correction to be 
performed for the respective pixel. 
 

 Correction radius 
With the correction radius you can determine in which 
pixel environment the correction calculations take place. 
A radius of 1 uses an environment of one pixel, i.e. a 
total of 3x3 pixels, a radius produces a correction matrix 
of 7x7 pixels. 
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 Colour Correction 
The colour correction is able to reduce the so-called 
colour cloudiness. Colour clouds are very soft and 
extensive colour noise. 

 
Note: In the practice of astrophotography a lot of dark frames 
are taken, which are then combined to a so called masterdark. 
Here 50 or more darkframe shots can be taken, which will then be 
added to the masterdark.  
 
As a rule of thumb, more dark frames than normal exposures 
should always be taken, so that the noise in the Masterdark is 
lower than in the Masterlight. 
 
You can do this directly in DENOISE projects 3 professional 
using the Stacking Image Sequence function. 
 
A flat frame – and what is that? 
 
Flat frames are exposed images of a uniformly illuminated 
surface. It is very important to take the flat frames with the same 
optics (i.e. filter, lens, etc.) as the exposures of the actual subject 
(light frames). 

With the help of these flat frames, brightness distortions such as 
vignetting of the camera and dust inclusions (sensor spots) are 
removed. 
 
Also with the flat frames in practice, as with the dark frames 
numerous photographs are made, which are then offset against 
each other to a Masterflat. 
 
As for the dark frames, the Stacking image sequence function 
has a special mode for stacking flat frames. 
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Original Dark frame Calibrated image 
 

 
 
Left in the picture you can see the original image with a 
brightness disturbance in the upper left half. 
 
The middle image is the recorded flat frame (masterflat) - here, 
too, the disturbance clearly shows up as a shadowing of the 
brightness. 
 
On the right side you can see the result image calibrated with the 
flat frame. The disturbance was completely removed. 
 
There is a parameter for the adjustment of the flat frame 
correction: 
 

 Flat frame intensity 
With the flat frame intensity the intensity of the flat 
frame correction can be readjusted if it is too weak. 

 
Note: The flat frames must also be offset against the dark 
frames. DENOISE projects 3 professional automatically does 
this for you in the background. 
 
A Bias frame – and what is that? 
 
A bias frame contains unwanted signal resulting from the 
electronics which elaborate the sensor data and not the unwanted 
signal within the sensor itself (as is the case with dark frames).  
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Original Bias frame 
 

            
 
 
As for the dark frames or flat frames, the Stacking image 
sequence function has a special mode for stacking bias frames. 
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11. Add Grain 
 
Even though DENOISE projects 3 professional was designed 
to remove noise from photos, it sometimes makes sense to add a 
"good" kind of noise. This trick will give you a much sharper look 
on some motifs. 
 

 
 
 
To change the noise level, use the "ISO" and "Size" sliders. 
When you have done this and want to reset them back to their 
original settings, click on this icon in the upper left corner:
    
 
You can also add a natural grain by clicking on "natural grain". 
Here you have the possibility to determine the shape of the grain. 
Six different shapes are available. 
 

 
 
To create a new, random distribution of the grain, click on the 
cube in the upper right corner:   
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With the following four options you can selectively edit lights and 
shadows in the photo: 
 

 All brightness areas receive natural film grain. 

 The lights receive a natural film grain. 

 The shadows receive a natural film grain. 

 The lights and shadows receive a natural film grain. 
  
 
The fractal grain simulates a large-area irregularity caused by 
the storage or aging of photographic material. Here you can also 
set "ISO" and "Quality". The quality determines the calculation 
accuracy (the number of iterations for the fractal algorithm) of 
the fractal grain. 
 
In general, the following applies to the grain size module: Here 
there is not the best setting, but the ideal grain size, shape and 
quality are 100% dependent on the motif. Here you can try it out 
and also break new ground.   
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12. Expert Mode 
 
The expert mode is used for fine adjustment of 
your image. After you have found a suitable 
setting for the automatic noise reduction, you 
can adjust all details in the expert mode.  

12.1 Magnifiying glass 

 
The magnifying glass shows you a 1:1 
comparison between the original image and the 
noiseless image. To do this, hold the mouse 
pointer at any position over the image. With 

the L key you can lock the magnifying glass to 
observe a specific area during processing. 
 
If an area is detected, a white broken line is 
displayed at the edge of the magnifying glass. 
 
Click into the image area of the magnifying 
glass to switch between the two display modes 
"split before/after comparison" and "direct 
before/after comparison". 
To release the detected area, press the L key 
again. 
 
You can also find the magnifying glass in post-
processing. 
 

12.2 Post-Processing effects (91) 
 

The list of available post-processing effects 
(filters) contains all the tools that make up the 
presets. 
 
Here you will find different types of effects: 
 

 Maskings (Smart-Mask) (black 
background) 
Masking details, Masking colour 
saturation, Masking colour shade, 
Masking lights, … 
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 Border effects (yellow background) 

Denoising, Sharpen, Erode, Dilate, … 
 

 Geometric effects (green background) 
Rotation & Zoom, Adjust horizon, correct perspective, … 
 

 Exposure effects (cyan background) 
Gradiation curve, Brightness control, Contrast, 
Brightness-Contrast-Gamma, Vignetting, … 
 

 Colour effects (blue background) 
Colour-Saturation-Exposure, Colour balance, chromatic 
correction, Manual white balance, … 
 

 Smoothing effects (violet background) 
Soft focus – keep details, Smooth colour tone 

 
A right click opens a so-called context menu. Here you can switch 
off the individual effect groups in order to get a better overview of 
the effects of an individual category. 
 
The most important effects for the noise reduction of your image 

are the edge effects, especially all effects that start with 
"denoising -".  
 
If you want to add a post-processing effect to the other effects of 
the current preset, double-click on the entry in the list and the 
effect will automatically be added to the list of "selected effects" 
at the end. 
 
 
Liste aller Post-Processing-Effekte 
 
DENOISE projects 3 professional offers you a wealth of 
different filters so that you can achieve the best result for every 
image with the least possible effort. You can choose from a total 
of 91 post-processing effects, which you can combine with each 
other and change individually. 
 
If you want to develop a feeling for these different filters, it is 
advisable to experiment with different images until you know 
which filter has which effect. To make it easier for you to get 
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started with DENOISE projects 3 professional, you can see 
each filter and its effect listed below in chronological order. Please 
note that different filters on different images can produce 
completely different results. 
 

12.3 Selected effects 

 
The list of selected effects 
represents the entire 
calculation process for the 
current image.  
 
The effects can be switched on 
or off by checking the box in 
front of the name.  
 
The small icon to the right of the check mark indicates whether a 
layer calculation (with a light bulb) or selective processing (red-
green circle) is active here. 
 
If you want to move an effect to 
another position in the 
calculation sequence, simply 

grab it with the mouse and 
move it to the desired position. 
The calculation is then 
automatically updated. 
 
Note: The order of the effect 
levels has a significant influence 
on the result depending on the 
combination. If, for example, 
you want to reduce chromatic 
aberrations, you should always 
do this before increasing the 
colour intensity. If you intensify 
the colours first, the aberrations 
will also be intensified. 
  
 
Right-click on the list of selected 
effects to open a context menu 
with the following functions: 
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 Deactivate effect 

 
 Activate all effects 
 Activate all other effects 
 Activate this effect only 
 Deactivate all effects 

 
 Duplicate effect 
 Restore effect 

 
 Send to end of list 
 Delete effect 

 
 Remove all the effects 

 
Once you have selected an effect, the parameters available for 
that effect appear directly below this area. 

12.4 Setting the parameters for the desired effect – 
calculation method 

 
Right at the beginning of the parameter area for the selected 
effect (here: Denoising - Colour) you will find the area of the 

layer calculation method. 
 

 
 
 
In the list above you can select a calculation method for the 
layer effect. There are many variations available, starting with 
simple methods such as brighten, darken, post-exposure and 
dodging. 
  
Note: Try this method out for yourself - if you reset the allocation 
method to Normal, you can deactivate the level allocation at any 
time. 
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On the right side you can also set the opacity for the current 
effect layer. If an effect is too strong for you, reduce the opacity a 
little until you like the result. 
 

12.5 Setting the parameters for the desired effect – 
selective editing 

 
Below the plane calculation you will find the buttons for selective 
processing. 

 
 
The functions from left to right: 
 

 Open selective editing  

 

 Copying Selective Areas to the Clipboard   

 
 Copy selective area from clipboard to current effect 

(existing areas will be replaced)   

 

 Delete all selective areas of the selected effect  

 
Selective processing is a special feature here. You can set up to 
32 selective areas for each effect layer. 
 
Selective areas can be positive (green) or negative (red) and you 
can mix them as you like. 
 
What is the effect of a positive selected area? 

With a positive area, you specify that the current effect layer is to 
be calculated in this area and not in the rest of the image. 
 
And what is the effect of a negative selected area? 
And what does a negative selective area do? 
Negative selective areas work exactly the other way round. With 
these you exclude the selected areas from the current effect 
layer. 
As soon as you have activated selective processing, a new 
window opens. In this window, you define the selective areas for 
the selected effect layer (here: Denoising - Colour). 
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The lower toolbar is used to create areas and display the masks 
created by the areas. 
 
The functions in detail are (from left to right): 
 

 Add positive selective area    

 

 Add negative selective area    

 
Invert the selected selective area  

(positive becomes negative and vice versa)  

  

 Duplicate the selected selective area   
 

 Delete the selected selective area    

 

 Invert all selective areas     
 

 Deactivate mask display    

  
 Display only the mask of the currently selected selective 

area       
 

 Display entire mask of selective areas   
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 Select the next selective area    

 

 Select the previous selective area    
  

For example, if you add a positive selective area for the Colour 
Luminosity effect. 
 
You can deform this area as you like. Use the mouse to grab the 
markers at the edge of the area and move the borders of the area 
to the desired shape. 
 
To move the area as a whole, simply drag the mouse into the 
rectangle and move the area to the desired position. 
 
As soon as you have selected a selective area, the three sliders at 
the top of the window are activated. Here you can exert additional 
influence. 
 

 
 
Curvature: 
The shape of the area can be adjusted from a rhombus (slider on 
the far left) to a rectangle (slider on the far right). 
 
Sharpness: 

Adjust the transition sharpness of the selective range from soft 
(slider far left) to sharp (slider far right). If, for example, you 
want to mask a window, select the rectangle=100% for the 
rounding and sharp=100% for the sharpness. 
 
Strength: 
The Strength determines the opacity of the selected selective 
area. In this way you can "slightly" exclude areas from the 
calculation. 
 
Once you have finished defining the selective areas, click Close at 
the bottom right. The settings are applied and the result image is 
updated. 
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12.6 Setting the parameters for the desired effect – 
adjusting the values 

 
In the area of the effect layer 
parameters, there are different 
types of data that you can 
change.  
 
In the example above, we see a 
"Intensity" control parameter.  
 
You can change these control 
parameters by setting them 
directly on the control or by 
entering a numerical value in the 
number field. 
 
A double-click on the "Handle" on 
the slider always resets the 
parameter to its default value. 
 
Directly below the slider you will 
see a masking curve with some 

default settings in the list above 
the displayed curve. 
 
With the Masking Curve you can 
automatically create a brightness mask. To do this, move the 
control points of the brightness curve to the desired strength. At 
the top edge, 100% effect strength means effect strength, at the 
bottom edge 0% effect strength. 
 
As you move one of the control points, you get a real-time display 
of the mask resulting from the curve. Light areas show a high 
strength for the effect and dark areas a low strength. 
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13. Local Adjustments/ selective drawing 

 

 
 

The selective highlight tool from DENOISE projects 3 
professional deserves very special attention. Firstly, this tool 
selectively edits chosen areas without complicated masks done by 
hand, like other photo editing programs. DENOISE projects 3 
professional includes a completely newly developed intelligent 
border recognition algorithm that independently identifies 
borders, lines, differentiations and light differences in drawing 
mode. The boundaries of the area that the mouse skimmed over 
are saved as a mask. These easily and precisely set masks serve 
as the basis for eleven important image enhancements: 
„Shading“, „Illuminating“, „Intensifying colour“, „Reduce colour“, 
„Strengthen details“, „Reduce details“ und „Selective denoising“, 
etc… 
These masks can even be saved as it´s own image file and used 
in other photo editing programs.    
How it all works is probably easiest to explain with an example. 
Open the selective drawing window (post-processing, finalise - 
bottom right). Our example is a single image file of a typical 
twilight on the beach. The picture’s colour details are already well 
edited. 
Now we want to slightly brighten the rocks without taking away 
the evening mood; the sky, water and beach should not be 
brightened.    
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 Quickly finalize your image with Selective Drawing 
1. Select editing objective  

For this case, select “Illuminating”. Make sure that the 
selected mask function is activated and the green 
checkmark is showing.    

 

2. Activate Drawing Mode    

3. Activate Filling Mode    

4. Run the mouse over the contours without clicking. You 
can decide and correct the brush size afterwards. 

 
5. Now look at the mask display. The object where the 

borders were automatically recognised is now depicted. 
Click and hold, and then trace your mouse along the 
edges of your chosen object until it is completely 
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selected. In the blink of an eye we will see the effect as 
well as the overlying mask.   

 
 

6. Once fully selected, blend the mask out by moving the 
mask intensity control to the left.   

 
7. You will now see only the effect that is brighter rocks - 

our objective was “Illuminating”. Now you can adjust the 
intensity of the effect by sliding the control towards the 
+ or -, according to your preferred strength. Done: the 
rocks are brighter while the sky, beach and water remain 
untouched by the editing.   

8. Click on “Close”. You will be returned to post-processing 
and the selective change will be applied. 



              

73 
 

 

 
The rocks on the left are significantly brighter after the 
selective correction. The sky and sea still have the same 
tone values as before.    
 

9. Use your quickly made mask for a further effect. Go back 
to the selective drawing. Our selective mask has 
remained.  

10. Click on  and copy the mask to the clipboard. Switch 

the mask to “Sharpen” and use the  to paste the 

mask back again. Now you have sharpened just the 
rocks, and the other parts of the image were not 
influenced. 

11. Every selectively applied effect can be activated and 
deactivated with the green checkmarks.    

12. Borders have different intensities in every image. Presets 
normally do just fine, but sometimes it is necessary to 
adjust the contour and sharpness settings in order to 
reach perfect fine-tuned results. 
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13. Have you drawn outside of the lines, despite the border 
recognition? You can easily remove it with the eraser 

.     If you only want to remove a small section, use 
the eraser with limitation. When set to 50%, you can 
only remove 50% of the mask, regardless of how much 

you erase. The limited drawing mode works in the same 
way, and only draws at a certain opacity. 

14. If you want to mask the entire image except for a small 
object, it is a good idea to mask only the small object 

and then reverse the mask by clicking on the  

 
Pro Tip:  You have two filling modes to choose from when you 
want to fill a mask. When do you use which mask? We used the 

normal fill mode  as in our example for a large surface, which 

is also preferred for water and sky areas 

Ray filling mode   is very precise and favoured for smaller 
objects, geometric forms or subjects with straight lines, like in our 
example here. 

 
With ray filling mode you can mask just the walls of the 
skyscraper while the window surfaces are not selected.    
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 Optional Mask Colours 

Designate a colour for the presentation of the mask as well as the 
brush one of the ready-made colours.  

 
The display will be immediately adjusted to your desired colour. 
 
 

 Selective Drawing – Creating Masks 

 
Masks can also be created from a colour or brightness. 

 
With the button (1) you activate the “Create Mask” modus. You 
will find yourself in the standard mode “Create Mask out of 
Colour”(2). If you want to create the mask from a brightness, 
chose the (3) button. 
The tolerance controller decides, how sharp (smaller value) or 
soft (higher value) the created mask will be. 
While you are in the “create mask” mode your mouse pointer will 
turn into a pipette. The colour or brightness in which your mouse 
pointer is set, will determine the type of mask being created. 
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In the above example we can see how a red mask has been 
created for the sky. 
 
Tip: If you want to combine several colours in one mask, simply 
click on the desired colours after each other with the pipette on 
the screen. The current colour will with every click be added to 
the current mask. 
 

 Selective Drawing – Smoothing Brush 

The smoothing brush (1) gives you the opportunity to draw 
selective areas of the mask softly.  
 

 
 
To draw an area even softer, just go over the same area with the 
smoothing brush several times. 

 

 Global Mask Functions 

In the area of global mask functions you will find several special 
modes that you can use directly. 

Undo of the last drawing steps     

Invert the current mask      

Deletes the current mask      

Minimizes the outline of the mask by one pixel   

Minimizes the outline of the masks by five pixels   

Enlarges the outline of the current masks by one pixel  

Enlarges the outline of the current masks by five pixels  

Slight smoothing of the whole mask    

Strong smoothing of the whole mask    

Copy the current mask to the clipboard    
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Paste the mask in the clipboard into the selected mask  

Saves the current mask as image file    

Uploads an image file into the current mask    

 

 Reset the Function of a Mask 

Every mask can be reset to its original state without effecting any 

other masks. Simply click on the waste paper button (1). 

 

After clicking on the button a security query will appear, so that 

no important work is lost by accident.  

 
 
 

- Adaptation of automatic masks in the “Distortion 

correction” section of the RAW module 

Selective drawing works directly with the RAW module. This 

includes the “Distortion correction” that is part of the RAW 

module and that is applied completely automatically on several 

drawn masks. 
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In the example we have an image, in which the sky has already 

been masked. 

When we now continue by correcting the horizon within the image 

in the RAW module, the drawn mask will automatically adjust 

itself to the “Distortioncorrection”. 
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 Composing Mode 
 

In the Composing mode of selective 

drawing you have the ability to build 

up to 4 layers of images into your 

current motif. 

To switch into the composing 

modus, click on the “composing” 

button (1). 

From the list of choices (2) you can 

choose with which composing level 

you want to work with. 

With the button (3) you activate the 

currently chosen mask. Now you can 

through a click on the frame of the 

image (4) upload any image you 

wish to create the next level. 

You can use RAW images, Jpg, Tiff 

as well as several other image 

formats. 

Underneath the display screen you 

will find the parameter area that 

begins with two buttons with the 

following functions: 

 

(5) Multiple applications 

Reduce the size of the image on a 

different level than the one that 

you´re currently working on. With 

this option you will be able to 

stretch the reduced image outwards 

(up, down, left, right). 

 

(6) Determine the width-to-

height ratio 
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This function allows you to determine the width-to-height ratio of 

the uploaded levels, since the width-to-height ratio in an 

uploaded image level can differentiate from the current image 

you´re working on. This preserves the proportion of the levels. 

 (7) Horizontal Reflection 

This function allows the image layer to be mirrored horizontally. 

This enables more precise adjustment to the current image 

without having to make changes to the image layer.  

(8) Vertical Reflection 

This function allows the image layer to be mirrored vertically. This 

enables more precise adjustment to the current image without 

having to make changes to the image layer.  

 (9) The Control-parameter 

Width-to-height ratio: If the width-to-height ratio isn´t fixed 

with the button (6), you will be able to change the width-to-

height ratio however you desire. 

Zoom: Choose the size of that image level by zooming in or out 

Shifting horizontally: Move the image level to the left or right 

Shifting vertically: Move the image of that level up or down. 

Exposure to light: Regularly the light from your current image 

does not match with the exposure of your other image levels. 

Here you can adapt the exposure and darken or brighten the 

images however you want, so that they match. 
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A night image with a not very fascinating night sky... 

 

....you can change within a minute with the help of 
composing into an eyecatcher.  
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14. Removal of Scratch and Sensor Errors 
 
You will find the scratch & sensor 
error correction on the right hand 
side in the "Finalise" section at the 
bottom for a good reason. A 
Scratch & Sensor Error Correction should always be done as the 
last step.  
 
As soon as you activate the correction, a new window opens: 
 

 
 
In the middle is the image and work area, the parameters are set 
on the right side. 
 
At the top on the right-hand side is the display control, starting 
with the radar view. You can zoom and pan the image in this 
view. 
 
Below the radar is the contrast display, which helps you find 
irregularities in the image better. 
 

 
 
Activate the contrast display with the front button and change the 
intensity of the display with the slider to the right. 
 



              

83 
 

 

 
 
These two buttons activate or deactivate the display of the 
correction areas (left) and the display of the target areas. 
 
In the area below there are two buttons which affect all correction 
areas. 

 
 
The left button calculates a new optimal target area for all set 
correction areas. With the right button you can delete all set 
correction areas, you must confirm this in a confirmation prompt. 
 
 
The lower setting block deals with the actual values of the 
correction areas: 
 
As you can see in the picture above, 14 of 200 possible correction 
areas are set here. 
 
To set another area, click on the brush, set the desired size with 
the slider to the right, and then click in the image area on the 
desired position for the correction. 
 
The target area of the correction is automatically searched for by 
the program, set accordingly and displayed to you. 
 
You can now move this target area with the mouse if you do not 
agree with the automatic suggestion. 
 
The "Size" slider at the bottom of this area allows you to 
subsequently change the size of a correction area. Simply click on 
a correction area and then change the size with the slider. 
The lower left button allows you to return a selected correction 
area to the automatic mode if you have defined the target area 
yourself. 
The lower right button deletes the currently active correction 
area.  
 
The keyboard layout of this window can be found in the chapter 
"Keyboard Shortcuts". 
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15. Astro Photography 
 
The following example should give you the opportunity to 
introduce the program to you in more detail – galaxy M31 – 
Andromeda.  
 
A sincere thank you at this point to Markus Jane, who provided 
the astro image sequences. 
 
The top photograph shows an individual image, while on the 
bottom you see the complete DENOISE projects 3 professional 
edited image.  

 
Applications used: 
20 exposures each for the exposure time of five minutes, 
calculated together to a „master light“  
 
20 dark frames calculated together to a “master dark” 
 
30 flat frames calculated together to a “master flat” 
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The Workflow: 
 

1. Stacking of dark frames with the function „stacking 
image sequences” to create the master dark. 

 
2. Stacking of flat frames with the function “stacking image 

sequences” to create the master flat. 
 

3. Stacking of light frames with the function „stacking 
image sequences” to create the actual image of the 
motive. This master light image you upload into the 
program.  
 
 

4. Now you upload the corrector image (master dark and 
master flat) over the control “load corrector image”, 
before activating the dark or flat frame calculation.  

 
5. In the export mode you can use the fine adjustments of 

the image. 
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16. Selecting and Saving Sections of Images 
 

To save a final image, click on the button in the toolbar, go 

through the file menu or use the corresponding keyboard 

shortcut (Ctrl + S).   

 

 Cropping and captions 

As soon as you have initiated a file save, the cropping and caption 

window will open. If you would not like to crop or add a caption to 

your image, click “continue”.  

 

At the top are several practical aids for perfect image composition 

and cropping.   

You can set the aspect ratio and activate guidelines like the rule 

of thirds, the golden section or the golden spiral.  The new photo 

centre display is also quite practical which you can access by 

simply clicking on this button. 

 

The centre of the window shows your final image. Fix the area to 

be saved by adjusting the corners and borders of the photo.   

At the bottom is an option to enter a caption. You can determine 

the size, position and background for the text. 



              

87 
 

 

The size of the text will be automatically coordinated to the final 

cropping. 

 You can either crop by hand 

or use one of the 71 provided 

formats.    

 

Please note: If you choose 

the cropping ration, 13 x 

18, for example the final 

image will not be saved as 

13 x 18 cm, rather as a 

ratio of 13 to 18.    

 

You will also find the "Scale 

and Save" button at the 

bottom. With this option you 

can choose between 30 different templates for various online 

platforms such as Facebook, Instagram, YouTube, etc. or simply 

specify your own scaling values (scaling in percent and resolution 

in pixels). 

 

As soon as the image has been cropped and captioned, confirm 

the save and the following window will prompt you to select a file 

format and name your file.   
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17. RAW Mode 

 
You can upload and edit RAW 

image data with the integrated 

RAW mode. Numerous tools are 

available to you here, such as 

denoising/sharpen, exposure, 

colour and detail as well as 

powerful distortion capabilities.   

 

In this RAW mode changes that 

are made will be transferred 

onto the entire bracketing 

series, so that you only have to 

put in the settings once. 

 

Resetting the category: 

Every category can through a click on the reset-button (bottom 

left) be reset to its original state without influencing the settings 

of the other categories. 
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Overview of the most important RAW functions:   

White balance: Here you can regulate the colour temperature. 

Use the pipette to select a white balancing colour directly from 

the image.    

Denoising/ Sharpness: This feature regulates the image’s noise 

and sharpness. Control the quality and different types of noise 

such as colour noise, banding or hot pixels.   

Colour balance/ white balance: Here it’s all about colour and 

black/white correction. Modify the general colour mood and 

neutralise white and black - the icing on the cake for professional 

colour correction.    

Exposure: Influence lights, shadows, contrast and brightness in 

the final image. With the new dynamic brightness you can adapt 

the light to the contents of each image individually. 

Details: Fine-tune clarity and micro-details with lights, shadows 

and midtones.    
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Colour: These colour settings are 

about luminosity in shadows and 

lights. Here you can also counteract 

unloved chromatic aberrations.  

The differentiated chromatic 

aberration by colour is used to 

remove chromatic aberrations of a 

certain colour. A lens curvature is 

calculated backwards on the 

selected colour channel. You have 

the choice between: "Light 

Diffraction Green", "Light 

Diffraction Blue" and "Light 

Diffraction Red".  

Palate: Adjust the saturation of 

individual colours.   

Distortion: Take a closer look. 

These mighty tools can straighten 

out the horizon, correct camera 

angles and lens errors. Use 

“Autofit” to automatically trim any 

awkward borders.    

 

The reference grid can be adapted 

in the distance between the grids 

as well as in its transparency. This is how you will always have 

the maximum overview when you are correcting your settings. 
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Lens correction: Corrects the edge light loss that occurs with 

some lenses. 

Peripheral light: Corrects the curvature of the lens. 

Horizon: Corrects the horizon by rotating the image. 

Vertical: Tilt the image left or right for vertical perspective 

correction. 

Horizontal: Tilt the image left or right for horizontal perspective 

correction. 

Zoom: Zooming the image avoids empty areas that may occur 

during distortion correction. 

Trapezoid left/ right: The vertical trapezoid correction pulls the 

image either at the left or right edge of the image and corrects 

the perspective. 

Trapezoid top/ bottom: Horizontal trapezoid equalization draws 

the image either at the top or bottom of the image and corrects 

the perspective. 

Stretch left/right: With this parameter you can stretch the 

image into the width, starting from the left or right edge of the 

image. 

Stretch top/ bottom: With this parameter you can stretch the 

image upwards, starting from the top or bottom edge. 

Aspect: Change the aspect ratio of your image files. 

Shift L-R: Shift the image files to the left or right. 

Shift U-D: Shift the image data up or down. 
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Category FX: 

 

This category contains special effects like a mist & fog correction, 

save highlights, sepia and film grains as well as different 

gradients. 

Pro Tip: 

When you take a landscape shot, shift the controller to “Gradient 

top” to a dark tone and create in that way a neutral thick (ND) – 

process filter. 

 

General:  

Activate the “360° panorama mode” to optimise matching edges 

of images in a panorama series. Save your settings as a camera 

profile to save time in the future. This can be reset at any time.    

If you have conducted the settings in RAW mode, click on “apply”. 
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If you save your settings in the camera profile, you will save a lot 

of time for future photographs. The settings can be reversed at 

any time. 

 

Zoom and Brightness 

At the top right are the sliders for zoom and brightness of the 

picture display.  

Note: With the brightness setting of the picture display, you do 

not change the brightness of your picture, but only the display, 

for example to be able to recognize the effect of a picture noise in 

darker areas. 

 

Histogram 

The histogram is located below the sliders.  

RGB: Here the RGB values of the pixel are displayed below the 

mouse pointer. 

HSL: Displays the HSL values of the pixel below the mouse 

pointer. 

Note: HSL stands for Hue (colour angle), Saturation (colour 

saturation) and Lightness 

(brightness). 
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18. Batch Processing 
 
Batch processing can be accessed via "Extras  Batch 

Processing" or the keyboard shortcut Ctrl + B. 
 
As soon as you have activated batch processing, a window opens 
with various settings and a graphical preview of the images found 
in the source folder. 
In the upper area, select the source directory for batch processing 
and enter a folder in the upper right corner where the results are 
to be saved. You specify the format directly below the target 
directory. 
 
If you check "include all subdirectories", you activate the 
recursive search for image data starting from the respective 
source folder. For very large folders, this function will take a little 
more time. 
 
Under "File filter" you can select whether you want to search 
only for certain file types or file names. You can search for RAW, 
Jpeg, Tif, Png or HDR formats. 
 
In the processing settings, you can select whether the noise 
reduction is to be automatic (in five different degrees of softness) 
or via a fixed default setting. As soon as you deactivate 
"Automatic denoising", you will see the list of available post-
processing presets at the position of the strength. 
 
Now that you have made all the settings, click on the "Start" 
button in the lower right corner and the batch processing will 
noise-deaden all the selected images and save them individually 
as TIF format. 
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19. Plug-in Installation 

 
DENOISE projects 3 professional allows you to use the 
software with a filter plug-in for Adobe Photoshop. Current 
Photoshop versions are automatically detected under Windows 
during the installation of DENOISE projects 3 professional and 
the plug-ins are installed in the respective plug-in folder. For 
older Photoshop versions, the plug-ins may have to be installed 
manually. 
 

19.1 Using Photoshop Plug-Ins in Windows 

During the installation of DENOISE projects 3 professional, 
the following window appears: 
 

 
 
Select the Photoshop version for which you want to install the 
DENOISE projects 3 professional plug-in. Then click "Next" 
and follow the instructions of the installation wizard. The 
corresponding plug-ins will then be installed automatically. 
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Note: With older Windows systems it can happen that the plug-
ins are not installed automatically. In this case, simply copy the 
desired plug-in into the appropriate folder as shown in the photo. 
 

 
 
You can also install the plug-ins at a later time. Please install 
Photoshop first, and then the projects plug-ins! 
 
After installing the plug-ins, please open Photoshop again.  
In Photoshop you will find the entry Franzis under the menu item 

"Filter". All plug-ins of the projects series are listed here. 

 
Click on DENOISE projects 3 professional. The image opened 
and edited in Photoshop will be opened in DENOISE projects 3 
professional. 
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The program is now in Photoshop Filter-Plugin mode. You can edit 
the image as usual in DENOISE projects 3 professional.  
 
Then use the "Apply" button to send the finished photo directly 
back to the Photoshop layer you came from. 
 

 
 
The "Cancel" button terminates the filter plug-in without sending 
your changes to the image back to the Photoshop layer. Editing in 
DENOISE projects 3 professional is cancelled.  
 
The projects program will then close automatically, a mechanism 
that is mandatory here in Adobe Photoshop. 
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19.2 Using Photoshop Plug-ins with MAC OS X 

 

 
 
You will find the plug-ins in the "Plug-Ins" folder in the start 
screen. In this folder select the folder that corresponds to your 
Photoshop version (in the following example Photoshop CS6 is 
selected). Double-click on the .zip file to unpack the plug-in.  
 
Then drag and drop the unpacked plug-in 
DENOISEprojects3ProfessionalFilter_PH6.plugin (PH7 for 
other Photoshop versions) into the plug-in folder of your 
Photoshop version. Normally this folder has the name "plug-ins": 

 
Now start your Photoshop version, load an image and navigate to 
 
„Menu Filter FranzisDENOISE projects 3 

professional“  
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With one click you start the plug-in. The image will now be 
opened in DENOISE projects 3 professional.  
 
The program is now in Photoshop Filter-Plugin mode. You can edit 
the image as usual in DENOISE projects 3 professional.  
 
Then use the "Apply" button to send the finished photo directly 
back to the Photoshop layer you came from. 
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The "Cancel" button terminates the filter plug-in without sending 
your changes to the image back to the photoshop layer. Editing in 
DENOISE projects 3 professional is cancelled.  
 
The projects program will then close automatically, a mechanism 
that is mandatory here in Adobe Photoshop. 

19.3 Using Adobe Lightroom Plug-ins - Windows 

 

Start the installation program and check whether "Lightroom 
Plugin" is selected in the component selection. 
 

Then open your Lightroom version. Start Lightroom and navigate 
to „File  Plugin-Manager“ to check if the plugin is activated. 
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LR: DENOISE projects 3 professional: Installiert und wird 
ausgeführt. 
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Markieren Sie eine Belichtungsreihe in Ihrer Lightroom-Bibliothek.  
Sie klicken mit der rechten Maustaste direkt auf die markierten 
Bilder und wählen den Eintrag „Exportieren  Exportieren 

nach DENOISE projects 3 professional“. 
 
Oder: Sie wählen Datei  Mit Vorgabe exportieren  

Exportieren nach DENOISE projects 3 professional“. 
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19.4 Using Adobe Lightroom Plug-ins - MAC OS X 

 
Das Plug-in für Adobe Lightroom wird bei MAC OS X nicht 
automatisch installiert. Um es in Lightroom zu integrieren, gehen 
Sie wie folgt vor:  
 
Installieren Sie DENOISE projects 3 professional in den 
Programme-Ordner Ihres Macs. 
 
Kopieren Sie von der CD das Plug-in-ZIP aus dem Ordner 
„Lightroom Plugin“. Dieses wurde zur Sicherheit in ein ZIP 
„gepackt“. Entpacken Sie das ZIP per Doppelklick und fügen Sie 
das Plug-in in einen Ordner Ihrer Wahl ein. 
Wir empfehlen den Ordner, in dem auch Ihre Presets gespeichert 
werden: 
 
 „Benutzer/Benutzername/Denoise 3 professional“. 
 

 
 
Starten Sie Lightroom und navigieren Sie zu „Datei  

Zusatzmodul-Manager“. 
 
Klicken Sie im Zusatzmodul-Manager auf „Hinzufügen“. 
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Wählen Sie das entsprechende Lightroom-Plug-in von DENOISE 
projects 3 professional aus, das Sie soeben auf Ihren Mac 
kopiert haben, indem Sie zu diesem navigieren. 
 
Sollte das Plug-in nicht sofort mit einem grünen Aktiv-Punkt 
gekennzeichnet sein, schließen und starten Sie Lightroom noch 

einmal. 
Nun sollte das Plug-in installiert und ausgeführt werden. 
 
Sie haben mehrere Möglichkeiten, Ihr Bild von Lightroom an 
DENOISE projects 3 professional zu übergeben.  
 
„Datei  Mit Vorgabe exportieren  Exportieren nach 

DENOISE projects 3 professional“. 
 
 
ODER: 
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Klicken Sie mit der rechten Maustaste in Lightroom direkt auf das 
Bild und wählen Sie den Eintrag „Exportieren  Exportieren 

nach Denoise projects 3 professional“. 
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20. Keyboard Shortcuts 
 

 

Overview of the integrated Keyboard shortcuts 
 
In the main menu in the area of information you will find an 
overview of all available keyboard shortcuts. 

 

 
 
Click on this item to open the overview: 
 

 
 
You can now scroll through the individual areas in the overview of 
keyboard shortcuts. 
 
To have permanent access to the shortcuts in an external 
window, you can use the function "Open in browser" (in the 
lower left window) and thus display the entire list in your 
standard browser or print it from there. 
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General functions 
 
Function Windows Mac OS 

   
New Project CTRL + N CMD + N 

Upload Single Image CTRL + SHIFT + O CMD + SHIFT + O 

Save Image  CTRL + S CMD + S 

Print final image CTRL + D CMD + D 

Insert final image into 

clipboard 

CTRL + C CMD + C 

Create undo point Shift Z Shift Z 

Open timeline CTRL + T CMD + T 

Exit programme CTRL + F4 CMD + F4 

Open RAW Module F4 F4 

Switch to post processing F7 F7 

Open setting CTRL + P CMD + P 

Open batch processing CTRL + B CMD + B 

Open homepage @ @ 

Open about dialogue Shift + F1 Shift + F1 

Display exif information  CTRL + E CMD + E 

Display/ hide histogram CTRL + H CMD + H 

Display full image CTRL + F CMD + F 

 
 

Image Display Functions 
 
Function Windows Mac OS 

   

Zoom in CTRL + CMD + 

Zoom out CTRL - CMD - 

Fit Image to Screen CTRL 0 CMD 0 

100% Display View CTRL 1 CMD 1 

Real-time Mode on/off R R 

Configure Radar Window (lock) L L 

 
 
RAW Developement 
 
Function Windows Mac OS 

   

Zoom in CTRL + CMD + 

Zoom out  CTRL - CMD - 
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History Browser 
 
Function Windows Mac OS 

   

Previous page Page up Page up 

Next page Page down Page down 

To start Home Home 

To end End End 

Previous entry Cursor left Cursor links 

Next entry Cursor right Cursor right 

 
Sensitive selektive Drawing 
 
Function Windows Mac OS 

   

Zoom in CTRL + CMD + 

Zoom out CTRL - CMD - 

100% Display View/ Adjust Fit CTRL 0 CMD 0 

Activate Brush Tool A A 

Activate Brush Tool with Limit SHIFT A 

 

SHIFT A 

 

Activate Eraser Tool S S 

Activate Eraser Tool with Limit SHIFT S SHIFT S 

Activate Blur Tool W W 

Activate Image Mask Creator E E 

Activate Fill Mode D D 

Activate Brush Fill Mode F F 

Activate Brush Streak Mode R R 

Reduce Brush Size 1 1 

Increase Brush Size 2 2 

Reduce Opacity 3 3 

Increase Opacity 4 4 

Soften Outline Recognition 5 5 

Sharpen Outline Recognition 6 6 

Reduce Blur 7 7 

Increase Blur 8 8 

Back One Step   CTRL Z CMD Z 

Mask Display On/Off M, SHIFT M M, SHIFT M 

 
 

Scratch & sensor error correction 
 

Function Windows Mac OS 

   

Zoom in CTRL + CMD + 

Zoom out  CTRL - CMD -  
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Move active correction area to 

the left 

Cursor/ Shift Cursor/ 

CTRL left 

Cursor/ Shift 

Cursor/ CMD left 

Move active correction area to 

the right 

Cursor/ Shift Cursor/ 

CTRL right 

Cursor/ Shift 

Cursor/ CMD right 

Move active correction area up Cursor/ Shift Cursor/ 

CTRL up 

Cursor/ Shift 

Cursor/ CMD up 

Move active correction area 

down 

Cursor/ Shift Cursor/ 

CTRL down 

Cursor/ Shift 

Cursor/ CMD down 

Select previous correction area Page up Page up 

Select next correction area Page down Page down 

Activate all correction areas C C 

Set new correction area N N 

Delete active correction area Del Del 

Increase active correction area + + 

Reduce active correction area - - 

 
Selective Processing 
 
Function Windows Mac OS 

   

Move selective area to 

the left 

Cursor/ Shift Cursor/ 

CTRL left 

Cursor/ Shift Cursor/ 

CMD left 

Move selective area to 

the right 

Cursor/ Shift Cursor/ 

CTRL right 

Cursor/ Shift Cursor/ 

CMD right 

Move selective area up Cursor/ Shift Cursor/ 

CTRL up 

Cursor/ Shift Cursor/ 

CMD up 

Move selective area 

down 

Cursor/ Shift Cursor/ 

CTRL down 

Cursor/ Shift Cursor/ 

CMD down 

Select previous 

selective area 

Page up Page up 

Select next selective 

area 

Page down Page down 

Delete active selective 

area 

Del Del 

Do not display mask 1 1 

Display mask of the 

active selective area 

2 2 

Display mask of all 

selective areas 

3 3 

 

 
Picture Cropping 
 
Function Windows Mac OS 

   

Move cropping 
area to left 

Cursor/ Shift Cursor/ CTRL 
left 

Cursor/ Shift Cursor/ CMD 
left 
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Move cropping 

area to right 

Cursor/ Shift Cursor/ CTRL 

right 

Cursor/ Shift Cursor/ CMD 

right 

Move cropping 

area upwards 

Cursor/ Shift Cursor/ CTRL 

up 

Cursor/ Shift Cursor/ CMD 

up 

Move cropping 

area downwards 

Cursor/ Shift Cursor/ CTRL 

down 

Cursor/ Shift Cursor/ CMD 

down 
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21. Integrated list of supported RAW formats 

 
In the main menu in the area information you will find an 
integrated list of supporting camera RAW-formats sorted by 
manufacturer. 
 

 
 
If you chose this menu item a camera RAW-format window will 
open. 
 

 
 
To have permanent access to the shortcuts in an external 
window, you can use the function "Open in browser" (in the 
lower left window) and thus display the entire list in your 
standard browser or print it from there. 
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